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ABSTRACT
Background: Early postnatal exposure to general anesthetics may interfere 
with brain development. We tested the hypothesis that isoflurane causes a 
lasting disruption in myelin development via actions on the mammalian target 
of rapamycin pathway.

Methods: Mice were exposed to 1.5% isoflurane for 4 h at postnatal day 7. 
The mammalian target of rapamycin inhibitor, rapamycin, or the promyelin-
ation drug, clemastine, were administered on days 21 to 35. Mice underwent 
Y-maze and novel object position recognition tests (n = 12 per group) on days 
56 to 62 or were euthanized for either immunohistochemistry (n  =  8 per 
group) or Western blotting (n = 8 per group) at day 35 or were euthanized for 
electron microscopy at day 63.

Results: Isoflurane exposure increased the percentage of phospho-S6–pos-
itive oligodendrocytes in fimbria of hippocampus from 22 ± 7% to 51 ± 6% 
(P < 0.0001). In Y-maze testing, isoflurane-exposed mice did not discriminate 
normally between old and novel arms, spending equal time in both (50 ± 5% 
old:50 ± 5% novel; P = 0.999), indicating impaired spatial learning. Treatment 
with clemastine restored discrimination, as evidenced by increased time spent 
in the novel arm (43 ± 6% old:57 ± 6% novel; P < 0.001), and rapamycin had 
a similar effect (44 ± 8% old:56 ± 8% novel; P < 0.001). Electron micros-
copy shows a reduction in myelin thickness as measured by an increase in 
g-ratio from 0.76 ± 0.06 for controls to 0.79 ± 0.06 for the isoflurane group  
(P < 0.001). Isoflurane exposure followed by rapamycin treatment resulted in 
a g-ratio (0.75 ± 0.05) that did not differ significantly from the control value 
(P = 0.426). Immunohistochemistry and Western blotting show that isoflurane 
acts on oligodendrocyte precursor cells to inhibit both proliferation and differ-
entiation. DNA methylation and expression of a DNA methyl transferase 1 are 
reduced in oligodendrocyte precursor cells after isoflurane treatment. Effects 
of isoflurane on oligodendrocyte precursor cells were abolished by treatment 
with rapamycin.

Conclusions: Early postnatal exposure to isoflurane in mice causes lasting 
disruptions of oligodendrocyte development in the hippocampus via actions on 
the mammalian target of rapamycin pathway.
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Modern general anesthesia allows the safe performance 
of several hundred million surgical procedures  

annually.1 However, there is growing concern that some 
vulnerable categories of patients, particularly young 

children, geriatric patients, and individuals with underlying 
brain disorders, may be at risk of lasting cognitive dysfunc-
tion.2–4 While conclusive evidence of anesthetic neuro-
toxicity has not been established in human studies, some 
animal studies have shown that exposure to general anes-
thetics in early development causes impaired neurocogni-
tive performance5–8 and that the peak period of behavioral 
and cognitive vulnerability to general anesthetics in rodents 
occurs in early postnatal life.9–11 Based on these studies, the 
U.S. Food and Drug Administration issued a warning that 

EDITOR’S PERSPECTIVE

What We Already Know about This Topic

•	 Oligodendrocyte proliferation and maturation are prerequisites for 
myelination in the central nervous system. Disruption of these pro-
cesses can lead to long-term impairment of neural function.

•	 Laboratory models demonstrate a variety of effects of anesthetics 
on the immature brain, but the consequences of early life anes-
thesia exposure on oligodendrocyte development have not been 
previously reported.

What This Article Tells Us That Is New

•	 Exposure of 7-day-old mouse pups to isoflurane (1.5%, 4 h) 
results in lasting impairments of oligodendrocyte proliferation and 
differentiation.

•	 These effects lead to defects in myelinations and are associated 
with cognitive dysfunction.

•	 The underlying molecular mechanisms involve the isoflurane- 
induced activation of the mammalian target of rapamycin path-
way and a related decrease in DNA methylation in oligodendrocyte 
progenitors.
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lengthy or repeated exposure to general anesthetics and 
sedative drugs from the third trimester of prenatal devel-
opment through the first 3 yr of life may cause lasting 
impairment in the cognitive function.12 The molecular and 
cellular mechanisms underlying this phenomenon remain 
poorly understood.

Most studies investigating anesthetic neurotoxicity 
have focused on neuronal development.7,13 However, brain 
function is also dependent on the myelin-forming oligo-
dendrocytes, which undergo critical developmental events 
during the putative window of vulnerability. Myelination 
involves proliferation of oligodendrocyte progenitor cells, 
differentiation of oligodendrocyte progenitor cells into 
mature oligodendrocytes, and ensheathment of axons. 
Myelin is critical for neurotransmission in the central ner-
vous system (CNS), and disruptions of myelin function are 
associated with neurologic and psychiatric disorders.14,15 In 
this study, we test the hypothesis that early postnatal expo-
sure to isoflurane affects oligodendrocyte development and 
myelin formation in the hippocampus in an in vivo mouse 
model. To establish the extent to which isoflurane-in-
duced deficits can be attributed to impaired myelination, 
we employed clemastine, an antimuscarinic drug approved 
for multiple sclerosis therapy, which promotes oligoden-
drocyte differentiation and myelination and reverses the 
phenotype of several murine disease models involving 
demylelination.16,17

Exposure to general anesthetics has been shown to 
impact molecular signaling pathways implicated in the 
dynamic maintenance of cellular homeostasis and develop-
ment.13 Recently, mammalian target of rapamycin (mTOR) 
signaling has emerged as a critical integrator of activity of 
nerve cells and synaptic inputs that in turn affect many cel-
lular metabolic processes.18 Studies have implicated mTOR 
signaling in neurodevelopmental and neuropsychiatric 
disorders.19 We previously showed that isoflurane disrupts 
development of newborn hippocampal neurons and syn-
aptic formation via activation of the mTOR pathway.7,20 
In this study, we further investigate the role of mTOR in 
isoflurane-induced neurotoxicity in mouse oligodendro-
cyte development and myelination using mTOR activity 
markers and rapamycin, a mTOR pathway inhibitor. We 
explored the effects on axon–oligodendrocyte precursor 
synapses, which are thought to be critical for turning oli-
godendrocyte development to match neuronal activity.21–23 
Activity in the mTOR pathway mediates DNA methyla-
tion in neurons24 and cancer cells,25 and it has been reported 
that DNA methylation is a well-recognized epigenetic 
modification that regulates oligodendrocyte development 
and is necessary for efficient myelin formation.26–28 Thus, 
the effect of general anesthetics and mTOR activation on 
DNA methylation level in oligodendrocytes has also been 
investigated.

Materials and Methods

Animal Paradigm and Experimental Timeline

A total of 120 (61 male and 59 female) immature C57BL/6 
mice (body weight = 4.4 ± 0.9 g at postnatal day 7) were 
used in this study. Eighty-four (44 male and 40 female) of 
them were randomly selected for the rapamycin experi-
ment and 36 (17 male and 19 female) for the clemastine 
experiment. Sex was not factored into the research design 
as a biologic variable. Both sexes were equally represented 
in all experiments. All study protocols involving mice 
were approved by the Animal Care and Use Committee 
at Johns Hopkins University (Baltimore, Maryland) and 
conducted in accordance with National Institutes of Health 
(Bethesda, Maryland) guidelines for care and use of animals. 
Experimental procedures followed the modified protocols 
from a previously published journal.7

At postnatal day 7, animals were exposed to isoflurane 
or room air for 4 h. From postnatal days 21 to 35, half of 
the isoflurane-exposed mice were injected intraperitoneally 
bidaily with rapamycin (n = 28 per group) or fed daily with 
clemastine through gastric gavage (n = 12 per group). The 
other half were injected with vehicle of rapamycin or fed 
with vehicle of clemastine.

For the rapamycin experiment, a subset of mice from 
each group was euthanized at postnatal day 35 for immu-
nohistochemistry (n  =  8 per group) or Western blotting 
(n = 8 per group). The remaining mice underwent behav-
ioral testing for spatial learning and memory functions 
between postnatal days 56 and 62 (n = 12 for each group). 
After behavior tests, two mice from each group were pro-
cessed for electron microscopy at postnatal day 63. Only 
behavior tests were conducted for the clemastine feeding 
experiment (n = 12 for each group; fig. 1A).

Isoflurane Exposure

At postnatal day 7, two thirds of the mice were evenly 
distributed across littermate groups and were randomly 
selected for isoflurane exposure. The other one third of the 
mice stayed in room air as a naive control. Volatile anesthesia 
exposure was accomplished using a Supera (USA) tabletop 
portable nonrebreathing anesthesia machine. Three percent 
isoflurane mixed in 100% oxygen was initially delivered in 
a closed chamber for 3 to 5 min, and after loss of righting 
reflex, animals were transferred to the specially designed 
plastic tubes. A heating pad (36.5°C) was placed underneath 
the exposure setup. The mice were exposed to 1.5% iso-
flurane carried in 100% oxygen for 4 h. A calibrated flow-
meter was used to deliver oxygen at a flow rate of 5 l/min, 
and an agent-specific vaporizer was used to deliver isoflu-
rane. During isoflurane exposure, mice were monitored for 
change in physiologic state using the noninvasive MouseOx 
plus instrument (STARR Life Sciences, USA). A collar clip 
connected to the instrument was placed on the neck and 
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a temperature probe placed on the skin of the abdomen. 
Ten-minute readings with 1-h intervals were taken. Data 
were collected at four time-points and averaged for each 
case. The skin temperature (34.1 ± 0.8°C), pulse disten-
tion (168.9 ± 36.6 µm), heart rate (376.8 ± 94.1 beats/
min), breath rate (77.4 ± 35.8 breaths/min), and oxygen 
saturation (99.3 ± 0.3%) were recorded. After the isoflurane 
exposure, mice were returned to their mothers together 
with their littermates upon regaining righting reflex. All 
animals (100%) survived the isoflurane exposure.7

Rapamycin Injection

A total of 84 mice were equally divided into three groups: 
(1) naive control, (2) isoflurane exposure plus vehicle, and (3) 
isoflurane plus rapamycin injection. From postnatal days 21 

to 35, half of the isoflurane-exposed mice (group 3; n = 28 
per group) were injected intraperitoneally with 0.2% rapa-
mycin dissolved in vehicle solution and the other half with 
vehicle only (group 2; n = 28 per group). Vehicle consisted 
of 5% Tween 80 (Sigma-Aldrich, USA), 10% polyethylene 
glycol 400 (Sigma-Aldrich), and 8% ethanol in saline. Mice 
received 100 μl rapamycin or vehicle for each injection at 
48-h intervals from postnatal days 21 to 35.7

Clemastine Feeding

In this experiment, 36 animals were also equally divided 
into three groups as above. Clemastine (Tocris Bioscience, 
United Kingdom) was dissolved in dimethylsulfoxide 
(Sigma-Aldrich) at 10 mg/ml followed by further dilution 
in double distilled water into 1 mg/ml. From postnatal days 

Fig. 1.  (A) Experimental timeline. A total of 120 mice (84 for rapamycin injection and 36 for clemastine feeding experiments) were used in 
this study. At postnatal day 7, two thirds of the mice were exposed to isoflurane (Iso) carried for 4 h, and the other one third of the animals 
remained in room air as naive controls. From postnatal days 21 to 35, isoflurane-exposed mice were injected intraperitoneally with rapamycin 
or vehicle at 48 h intervals, or daily fed with clemastine or vehicle. Mice were euthanized at postnatal day 35 for immunohistochemistry and 
Western blotting, or at postnatal day 63 for electron microscopy. The novel objective position recognition test and Y-maze test were performed 
during postnatal days 57 to 62. (B) Effect of early isoflurane exposure on mammalian target of rapamycin pathway activity in oligodendrocytes 
of hippocampus fimbria. Coronal brain sections from control, isoflurane exposure, and isoflurane plus rapamycin groups were immunostained 
with adenomatous polyposis coli (APC; green) and phospho-S6 (pS6; red) antibodies. Arrows indicate phospho-S6–positive and adenomatous 
polyposis coli–positive double-labeled cells (yellow) in merged images. Scale bar = 10 μm. The histogram shows quantitative results. In 
isoflurane-exposed mice, the ratio of phospho-S6–positive/adenomatous polyposis coli–positive over adenomatous polyposis coli–positive 
cells is dramatically increased compared to control, and this increase is reversed with rapamycin treatment. n = 8 for each group; one-way 
ANOVA; **P < 0.01; ****P < 0.0001. Error bars: SD. EM, electron microscopy; IHC, immunohistochemistry; WB, western blot.
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21 to 35, half of the isoflurane exposed mice (n = 12 for 
each group) were fed clemastine (10 mg/kg) daily via gas-
tric gavage using plastic feeding tubes (gauge 22; Instech, 
USA), and the other half (n = 12 for each group) were fed 
same volume of 10% dimethylsulfoxide as vehicle.16,17

Behavior Tests

The novel object position recognition test and Y-maze test 
were performed at the last week of the survival period 
(postnatal days 56 to 62).7 Experimenters were blinded 
to condition when behavioral tests were carried out and 
quantified.

1.	 Novel object position recognition test: The test was 
assessed in a 27.5 cm × 27.5 cm × 25 cm opaque chamber. 
During the pretest day (day 1), each mouse was habitu-
ated to the chamber and allowed to explore two identical 
objects (glass bottles, 2.7 cm diameter, 12 cm height, and 
colored paper inside) for 15 min. The mouse was then 
returned to its home cage for a retention period of 24 h. 
On the test day (day 2), the mouse was reintroduced to 
the chamber and presented with one object that stayed in 
the same position (old position) while the other object 
was moved to a new position (novel position). A 5-min 
period of movement and interaction with the objects was 
recorded with a video camera that was mounted above 
the chamber, and exploratory behavior was measured by 
a blinded observer. Exploratory behavior was defined as 
touching the object with snouts. The numbers of explor-
atory contacts with the novel object and with the old 
object were respectively recorded, and the ratios over the 
total exploratory contact numbers were calculated.

2.	 Y-maze test: In the pretest phase (day 1), mice explored and 
habituated in the start arm (no visual cue) and one out of 
two possible choice arms with overt visual cue (old arm) 
for 15 min. This was followed by the recognition phase 
(day 2) 24 h later, in which the animals could move freely 
in the three arms and choose between the two choice arms 
(old arm and novel arm) after being released from the start 
arm. The timed trials (5 min) were video recorded as well 
as graded by an observer blinded to the conditions for 
exploration time in each choice arm, and the percentages 
over total exploratory time were calculated.

Immunohistochemistry

During postnatal days 30 to 35, 5-bromo-2’-deoxyuridine 
(Abcam, United Kingdom) was injected intraperitoneally 
at 50 mg/kg daily in animals randomly selected from three 
groups (n = 8 for each group). At postnatal day 35, mice 
were perfused with 40 ml 4% paraformaldehyde in phos-
phate buffered saline. Brains were removed and postfixed at 
4°C overnight, followed by 30% sucrose in phosphate buff-
ered saline at 4°C for 48 h. The brains were coronally sec-
tioned in 40-μm thickness using a freezing microtome. For 
each brain, 72 sections containing fimbria were collected 

in a 24-well tissue culture plate, and they were divided into 
12 wells in a rotating order (six sections per well). Seven 
wells of sections were immunostained for (1) phospho-S6 
and adenomatous polyposis coli, (2) 5-bromo-2’-deoxyuri-
dine and neural/glial antigen 2, (3) adenomatous polyposis 
coli and platelet-derived growth factor receptor alpha, (4) 
vesicular glutamate transporter 1 and neural/glial antigen 2, 
(5) myelin basic protein, (6) DNA methyltransferase 1 and 
Olig2 (oligodendrocyte transcription factor marker), and 
(7) 5-methylcytosine and adenomatous polyposis coli. For 
5-bromo-2’-deoxyuridine staining, sections were pretreated 
with 2 Normal HCl to denature DNA (37°C; 45 min), and 
with 2 × 15 min borate buffer (pH 8.5) to neutralize the 
HCl. After 3 × 10 min phosphate buffered saline wash-
ing, sections were blocked in 10% normal goat serum and 
0.1% Triton X-100  (Sigma-Aldrich) for 60 min, followed 
by primary antibody incubation at 4°C overnight. Primary 
antibodies used in this study were rabbit anti–phospho-S6 
(1:1,000; Cell Signaling, USA), mouse anti–5-bromo-2’-de-
oxyuridine (1:200; Abcam), rabbit anti–neural/glial antigen 
2 (1:200; Millipore, USA), mouse anti–adenomatous pol-
yposis coli (1:2,000; Millipore), mouse anti–myelin basic 
protein (1:500; Santa Cruz Biotechnology, USA), rabbit 
anti–platelet-derived growth factor receptor alpha (1:500; 
Lifespan Bio, USA), mouse anti–vesicular glutamate trans-
porter 1 (1;200; Abcam), mouse anti–DNA methyltransfer-
ase 1 (1:100; Santa Cruz Biotechnology,), rabbit anti-Olig2 
(1:2,000; Abcam), and rabbit anti–5-methylcytosine 
(1:2,500; Abcam). After 3 × 10-min washes in phosphate 
buffered saline, sections were incubated with secondary 
antibodies for 2 h: Alexa 488–conjugated goat anti-rabbit 
IgG (1:300; Invitrogen, USA) mixed with Cy3-conjugated 
goat anti-mouse IgG (1:600; Jackson ImmunoResearch 
Labs, USA), or Alexa 488–goat anti-mouse IgG (1:300; 
Invitrogen) mixed with Cy3-conjugated goat anti-rab-
bit IgG (1:600; Jackson ImmunoResearch Labs). After 3 
× 10-min phosphate buffered saline washes, sections were 
mounted onto slides, air-dried, and cover-slipped.21

Cell Counting and Immunofluoresce Intensity Analysis in 
Fimbria

The sections were observed and imaged using a Leica 4000 
confocal microscope (Germany). All single- or double-im-
munolabeled cells within hippocampal fimbria area were 
counted using ImageJ with cell counter plugin (National 
Institutes of Health). The criteria for counting mTOR 
active oligodendrocytes required a cell to have both phos-
pho-S6–positive (in red channel) and adenomatous polypo-
sis coli–positive (in green channel) cytoplasm, and a merged 
image of double-labeled cells appeared yellow (fig.  1B). 
Proliferating oligodendrocyte progenitor cells and 5-meth-
ylcytosine–positive oligodendrocytes were counted for cells 
that have 5-bromo-2’-deoxyuridine–positive or 5-meth-
ylcytosine positive nuclei and neural/glial antigen 2–pos-
itive or adenomatous polyposis coli-positive cytoplasm. 
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However, both DNA methyltransferase 1 and Olig2 reac-
tivity were seen in nuclei. Identification of excitatory 
axon–oligodendrocyte progenitor cell synapses involved 
vesicular glutamate transporter 1–positive terminal bou-
tons closely apposing on the surface of neural/glial antigen 
2–positive oligodendrocyte progenitor cells. For adeno-
matous polyposis coli and platelet-derived growth factor 
receptor alpha double-stained sections, almost no dou-
ble-labeled cells were seen, which means these two markers 
label cells in different oligodendrocyte development stages 
without overlapping.

Images containing fimbria were taken at 20× magnifica-
tion in red (Cy3), green (Alexa 488), and merged channels. 
All single- (Cy3+ or Alexa 488+) and double-labeled cells in 
fimbria were counted. Images were opened and initialized in 
ImageJ. The fimbria area was outlined using the ‘‘Freehand’’ 
tool. “Plugins,” “Analysis,” and ‘‘Cell Counter’’ tools were 
selected, and each labeled cell inside was clicked, with 
which each counted cell was marked, preventing the same 
cell from being counted twice. The numbers of counted 
cells were automatically recorded. The ratio of a specific 
marker labeled oligodendrocytes (such as yellow-colored 
phospho-S6–positive/ adenomatous polyposis coli–positive 
cells over all green adenomatous polyposis coli–positive 
cells in fig. 1B) was calculated. For each case, numbers from 
12 fimbria images (six sections, both sides) were averaged. 
There was almost no double-staining for adenomatous 
polyposis coli and platelet-derived growth factor receptor 
alpha. We then used the ratio of adenomatous polyposis 
coli–positive over platelet-derived growth factor receptor 
alpha–positive cells to evaluate the maturation of oligoden-
drocyte lineage cells. For axon–oligodendrocyte progenitor 
cells synapse, five neural/glial antigen 2–positive cells from 
each image (60 cells for each case) were randomly selected, 
and photos were taken in a higher magnification (40×). All 
vesicular glutamate transporter 1–positive terminal boutons 
apposing on each selected cell were counted with ImageJ, 
and average numbers were calculated.

The fluorescence intensity of myelin basic protein 
immunoreactivity in fimbria was also quantitatively ana-
lyzed using ImageJ. Photos of the fimbria area from 
immunostained sections were taken at 20× magnification. 
Identical photo exposure was set for all groups. The image 
was opened with ImageJ, and an outline of fimbria was 
drawn with “Freehand” tool. The “set measurements” was 
selected from the analyze menu, and “integrated density” 
was activated. A region in lateral ventricle was selected as 
background. The final myelin basic protein intensity of fim-
bria area equals measured density minus background.

Western Blotting

Eight animals from each group were quickly perfused with 
cold saline on day 35. From the medial aspect of the hemi-
sphere, the hippocampus was exposed and separated from 
brain tissue. Fimbria located in the ventrolateral side of the 

hippocampus were easily identified by their bright white 
color under dissection microscope, and then removed with 
fine forceps. Fimbria tissue was lysed in the lysis buffer, 
homogenized with a bullet bender (Next Advance, USA), 
and centrifuged. The supernatant was taken and stored in 
–80°C. The next day, samples were prepared with 1:1 dena-
turing sample buffer (Bio-Rad, USA), boiled for 5 min, and 
run on 4 to 12% Bis-Tris Protein Gels (Invitrogen) in run-
ning buffer (Invitrogen) with 150 volts for about 1 h. The 
proteins were transferred to nitrocellulose blotting mem-
branes (Invitrogen). Blots were probed with anti–neural/
glial antigen 2 (1:200; Millipore), anti-NK2 homeobox 
2 (1:200; Abcam), anti-myelin basic protein (1:500; Santa 
Cruz Biotechnology), anti-DNA methyltransferase 1 (1:100; 
Santa Cruz Biotechnology), and anti–β-actin antibodies 
(1:1,000; Cell Signaling Technology). The membranes with 
the primary antibodies were stored in 4°C overnight. After 
incubation in secondary antibodies (1:2,000; Cell Signaling 
Technology) for 1 h, blots were visualized using an ECL 
Western blotting substrate kit (Pierce Biotechnology, USA). 
Images were acquired using the ChemiDoc imaging sys-
tem (Bio-Rad) and were quantitated with ImageJ. First, 
the images were opened using “File>Open.” The rectan-
gles around all lanes (each lane includes bands for detected 
marker and β-actin) were drawn by choosing “Rectangular 
Selection.” Then, proceeding to “Analyze>Gels>Plot 
Lanes,” peaks were generated representing the density of 
bands, followed by clicking the “Straight Line” tool to 
enclose the peaks and selecting the “Wand” tool to high-
light the peaks. After this, “Analyze>Gels>Label Peaks” was 
used to get numbers for the peak area (band intensity). The 
ratios of band density of oligodendrocyte lineage markers 
over β-actin were calculated.21

Electron Microscopy

Two animals from each group were perfused with 2% glu-
taraldehyde (Electron Microscopy Sciences, USA) plus 2% 
paraformaldehyde (Electron Microscopy Sciences) in phos-
phate buffered saline at postnatal day 63 (after behavior 
tests) and postfixed at 4°C for 1 week. Brains containing 
fimbria were dissected into small blocks (2 mm × 2 mm × 
2 mm). The blocks were placed into 1% osmium tetraox-
ide (Electron Microscopy Sciences) for 1 h, stained in 0.5% 
uranyl acetate (Electron Microscopy Sciences) overnight, 
and dehydrated in a series of alcohols followed by propyl-
ene oxide for 3 h. After being infiltrated with a 1:1 mix-
ture of propylene oxide and EMBed-812 embedding resin 
(Electron Microscopy Sciences) for 3 h, the blocks were 
embedded with the same resin in the plastic templates at 
60ºC overnight.21 Parasagittal semithin sections (1 μm) were 
cut and stained with 1% Toluidine blue (Sigma-Aldrich) for 
preliminary light microscopy observation. Then, 90-nm 
ultrathin sections were cut, picked up on Forvar-coated 
slotted grids  (Electron Microscopy Sciences), and stained 
with 0.5% uranyl acetate and 0.5% lead citrate (Electron 
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Microscopy Sciences). Thin sections were observed and 
imaged with a Hitachi 7600 transmission electron micro-
scope (Chiyoda, Japan). For each case, 10 photos were ran-
domly photographed at 20,000×. The thickness of myelin 
was quantitatively measured by determining the g-ratio, 
which was calculated by dividing the diameter of the axon 
by the diameter of the entire myelinated fiber as previously 
described. ImageJ was used by first opening ultrastructural 
images. The scale was set according to the scale bar in the 
images by selecting “Analyze>Set Scale.” The “straight line 
tool” was selected to measure axonal caliber and diameter 
of myelinated axons. One hundred axons per group (2 ani-
mals, 50 from each) were randomly selected and quantita-
tively analyzed (n = 100).16

Statistical Analysis

The statistics were performed with GraphPad Prism 6 (USA) 
program. The sample size was based on our previous experi-
ence with this design. No a priori statistical power calculation 
was conducted. Normal distribution was verified using the 
D’Agostino–Pearson test. Data for immunohistochemistry, 
Western blotting, and electron microscopy were analyzed 
using one-way ANOVA. The factor of variable was compar-
isons among groups (control vs. isoflurane plus vehicle vs. 
isoflurane plus rapamycin). The behavior tests were analyzed 
with two-way ANOVA. For this analysis, the second factor 
was the animal’s choice between old versus novel positions 
(or arms), and only the values for this variable in each indi-
vidual group were compared. The Tukey post hoc test was 
employed for intergroup comparisons. The two-tailed test 
was set according to convention. The criterion for significant 
difference was set a priori at P < 0.05. In this study, all results 
were expressed as mean ± SD. The sample size “n” represents 
the number of animals for each group. The only exception 
is g-ratio analysis with electron microscopy, in which “n” 
indicates the number of randomly selected axons from two 
mice per group (n = 100). This analysis method is extensively 
applied for g-ratio study.16 Because all animals survived tests, 
there were no missing data in this study. No exclusions for 
outliers were made in this study. In some experiments, the 
sample size was increased in response to peer review.

Results

Effect of Early Isoflurane Exposure on mTOR Activity in 
Oligodendrocytes in Hippocampal Fimbria

All experiments compared the three groups as follows: naive 
control, isoflurane exposure plus vehicle, and isoflurane 
exposure plus treatment (rapamycin or clemastine). We first 
assayed for activity in the mTOR pathway in oligodendro-
cytes by double-labeling for phospho-S6, a reliable reporter 
of activity in this pathway,29 and adenomatous polyposis 
coli, a standard marker for oligodendrocyte. In the con-
trol group, 22 ± 7% adenomatous polyposis coli–positive 

oligodendrocytes in fimbria were also immunolabeled for 
phospho-S6. There was a profound increase in the per-
centage of phospho-S6–positive/ adenomatous polyposis 
coli–positive cells over adenomatous polyposis coli–positive 
cells to 51 ± 6% in isoflurane exposure mice (P < 0.0001). 
However, this increase of phospho-S6–positive/adeno-
matous polyposis coli–positive cells over adenomatous pol-
yposis coli–positive cells was prevented by treatment with 
rapamycin (32 ± 12%; P = 0.001). These data indicate early 
exposure of a general anesthetic agent causing a lasting 
increase in the activity of the mTOR signaling pathway 
in the oligodendrocytes of hippocampus white matter, and 
rapamycin attenuates this increase.

Effect of Isoflurane Exposure on Spatial Learning

Next, we asked whether isoflurane exposure impairs spatial 
learning and memory behaviors using the novel objective 
position recognition test (fig. 2A) and Y-maze test (fig. 2B), 
and whether treatment with rapamycin or clemastine 
restores these functions in our exposure paradigm.

1. 	Rapamycin study: In the novel object position rec-
ognition test, control animals made 58 ± 8% con-
tacts with the object that had been repositioned as 
compared to 42 ± 8% contacts with the unchanged 
object (P < 0.0001). The isoflurane-exposed mice 
made essentially equal contacts at both objects (53 ± 
6% vs. 47 ± 6% times; P = 0.398). Rapamycin treat-
ment restored the performance to near control levels 
(55 ± 8% vs. 45 ± 8% times; P = 0.016; fig. 2C). In 
the Y-maze test, control animals exhibited a higher 
percentage of exploration time in novel arm (58 ± 
5% exploration time) compared to the old one (42 
± 5% exploration time; P < 0.0001). Isoflurane-
exposed animals without rapamycin treatment had 
equal exploration times in both arms (50 ± 5% vs. 50 
± 5% duration; P = 0.999), and rapamycin treatment 
restored performance in this task (56 ± 8% vs. 44 ± 
8% duration; P < 0.001; fig. 2D).

2. 	Clemastine study: In the novel object recognition test, 
control animals made more contacts with the object 
in the novel position (57 ± 8% vs. 43 ± 8% times; 
P = 0.007), but isoflurane exposed animals exhibited 
no exploration preference (51 ± 10% vs. 49 ± 10% 
times; P = 0.998). Clemastine treatment increased the 
difference near the control cases (56 ± 7% vs. 44 ± 
7% times; P = 0.028; fig. 2E). Similarly, in the Y-maze 
test, unlike controls (58 ± 6% vs. 42 ± 6% duration; 
P < 0.0001), isoflurane-exposed mice spent identical 
time in both old and novel arms (51 ± 7% vs. 49 ± 7% 
duration; P = 0.999), and this effect of isoflurane was 
reversed by clemastine treatment (57 ± 6% vs. 43 ± 6% 
duration; P < 0.001; fig. 2F).
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Effects of Isoflurane on Oligodendrocyte Development

In order to measure the proliferation of oligodendrocyte 
progenitor cells, the brain tissue was immunolabeled with 
antibodies against 5-bromo-2’-deoxyuridine and an oli-
godendrocyte progenitor cells marker, neural/glial antigen 
2. We examined proliferating oligodendrocyte progenitor 
cells by counting 5-bromo-2’-deoxyuridine and neural/
glial antigen 2 double-labeled cells in fimbria. We counted 
49 ± 14% neural/glial antigen 2–positive oligodendrocyte 

progenitor cells in controls, and 27 ± 9% neural/glial anti-
gen 2–positive cells in isoflurane-exposed animals were 
5-bromo-2’-deoxyuridine–positive (P = 0.001). This ratio 
number increased to 47 ± 7% (P = 0.003) in the isoflu-
rane plus rapamycin injection group (fig. 3A). Interestingly, 
we found that neural/glial antigen 2 expression from 
Western blot in the isoflurane exposure group (83 ± 20% 
intensity over β-actin) is slightly lower than the control  
(87 ± 15%; P  =  0.882) and rapamycin treatment groups 
(89 ± 17%; P = 0.819), but there is no statistical difference 

Fig. 2.  Isoflurane impairs cognitive functions via mammalian target of rapamycin activity. (A) Novel object recognition test (NOPR). On day 1, 
mice were allowed to explore two identical objects in an opaque chamber. On day 2, one object was moved to a novel position. Exploratory 
behavior was defined as the number of object-contacting with snouts. (B) Y-maze test. On day 1, mice habituated in the start arm and one 
choice arm. On day 2, the animal could choose between two arms. Exploration time in both arms was respectively recorded. (C) Novel object 
recognition test for rapamycin study. Control animals made more contact with the object in the novel position than that in the old position. 
Isoflurane-exposed mice have identical contacts for both positions. Rapamycin treatment restores performance to near control levels. (D) 
Y-maze study. Control animals stayed in the novel arm for longer time than in the old arm. Isoflurane-exposed animals stayed in both arms 
for same time. Rapamycin treatment reversed this ratio to near control. (E) Novel object recognition test for clemastine study. Control animals 
spent more time exploring the object in the novel position, but isoflurane-exposed animals exhibited no exploration preference. Clemastine 
treatment increased difference near the level of control animals. (F) Y-maze test. Similarly, isoflurane mice spent identical time for both arms, 
but this effect of isoflurane was reversed by feeding clemastine. The statistics were two-way ANOVA. n = 12 for each group; *P < 0.05; 
**P < 0.01; ***P < 0.001; ****P < 0.0001; ns, no significance. Error bars: SD.
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among groups (fig. 3B). However, expression level of NK2 
homeobox 2, a transcription factor that identifies oligo-
dendrocyte differentiation, was downregulated by iso-
flurane (67 ± 16% vs. 32 ± 10% intensity over β-actin; 
P = 0.001), and rapamycin attenuated this effect (58 ± 22% 
intensity over β-actin; P = 0.015; fig.  3B). We then per-
formed double-immunolabeling for adenomatous polyp-
osis coli and the oligodendrocyte progenitor cell marker 
platelet-derived growth factor receptor alpha, and applied 
oligodendrocyte/oligodendrocyte progenitor cell ratio as a 
parameter to evaluate the oligodendrocyte differentiation in 
fimbria.30 The ratio of the number of adenomatous polypo-
sis coli–positive mature oligodendrocytes over the number 
of platelet-derived growth factor receptor alpha–labeled 

oligodendrocyte progenitor cells in isoflurane-exposed 
mice (233 ± 43%) revealed lower than in control (347 ± 
70% cells; P = 0.002), and rapamycin treatment increases 
this ratio (338 ± 52% cells; P = 0.003; fig. 3C).

To test the effects of isoflurane on axon–oligoden-
drocyte progenitor cell synapses, we identified excitatory 
axon–oligodendrocyte progenitor cell synapses in the fim-
bria as puncta that were immunopositive for vesicular gluta-
mate transporter 1, which were closely apposed on neural/
glial antigen 2–positive cell bodies. We found that the num-
ber of axon–oligodendrocyte progenitor cell synapses on 
each oligodendrocyte progenitor cell in isoflurane exposure 
(0.8 ± 0.6 vGlut1+ terminals per oligodendrocyte precursor 
cell) showed a statistically significant reduction compared to 

Fig. 3.  The effect of isoflurane (Iso) exposure and rapamycin treatment on oligodendrocyte development in fimbria. (A) Oligodendrocyte 
progenitor cell proliferation was detected with 5-bromo-2’-deoxyuridine and neural/glial antigen 2 double-immunolabeling. A reduction in 
5-bromo-2’-deoxyuridine–positive/neural/glial antigen 2–positive cells in isoflurane-exposed animals was observed compared to the control. 
This number was increased in isoflurane plus rapamycin injection group. Scale bar = 20 μm. (B) Western blot data indicated that the neural/
glial antigen 2 level was not altered by isoflurane exposure and rapamycin administration. Expression of NK2 homeobox 2, a transcript factor 
for oligodendrocyte differentiation, was downregulated by isoflurane, and rapamycin treatment attenuated this effect. (C) Oligodendrocyte 
differentiation was analyzed with lineage tracing using immunohistochemistry. The ratio of adenomatous polyposis coli–positive mature oli-
godendrocyte number over platelet-derived growth factor receptor alpha–positive oligodendrocyte progenitor cells in isoflurane-exposed mice 
revealed reduction compared to control, and rapamycin treatment increases the ratio. Scale bar = 20 μm. n = 8 for each group; one-way 
ANOVA; *P < 0.05; **P < 0.01; ns, no significance. Error bars: SD. APC, adenomatous polyposis coli; PDGFR-α, platelet-derived growth factor α.
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control (2.6 ± 1.2 terminals per cell; P = 0.001), and rapa-
mycin treatment rescued these synapses (2.2 ± 0.7 per cell; 
P = 0.008) from isoflurane exposure (fig. 4).

Effects of Isoflurane Exposure on Myelination

To test for changes in myelination after anesthesia exposure, 
we measured fluoresce intensity of immunolabeling for the 
myelin basic protein in fimbria. We found an immunointen-
sity reduction in isoflurane exposure (70 ± 18% intensity 
over control) compared to control conditions (100 ± 17% 
control; P = 0.006), which were partially restored with rapa-
mycin treatment (92 ± 17% rapamycin treatment; P = 0.041; 
fig. 5A). We then conducted Western blot from fimbria tis-
sue to confirm this finding. The band intensity of myelin 
basic protein over β-actin showed a statistically significant 
decrease by isoflurane exposure (110 ± 30% vs. 60 ± 19% 
intensity ratio; P = 0.002), and expression of myelin basic 
protein was restored with rapamycin treatment (100 ± 26% 
intensity ratio; P = 0.013; fig.  5B). For further confirma-
tion, we conducted electron microscopy to test for changes 
in the thickness of myelin wraps after isoflurane exposure. 

The quantitative analysis revealed a statistically significant 
increase of g-ratio (thinner myelin sheath) in isoflurane-ex-
posed animals than control (0.76 ± 0.06 vs. 0.79 ± 0.06 
g-ratio; P < 0.001), and rapamycin treatment reversed this 
difference (0.75 ± 0.05 g-ratio; P < 0.0001; fig. 5C).

Effects of Isoflurane Exposure on DNA Methylation in 
Oligodendrocytes

We asked if early exposure to isoflurane has a lasting effect on 
DNA methylation levels in oligodendrocytes. We observed 
that 60 ± 15% of Olig2+ cells (a transcription factor marker 
for oligodendrocyte lineage cells) in control conditions were 
double-labeled with DNA methyltransferase 1 in fimbria as 
compared to only 42 ± 12% Olig2+ cells (P = 0.027) in the 
isoflurane exposure group. Rapamycin treatment after isoflu-
rane exposure increased the ratio of DNA methyltransferase 
1+/Olig2+ over Olig2+ cells (62 ± 11% ratio; P = 0.01; fig. 6A). 
Western blots were conducted which confirmed that DNA 
methyltransferase 1 expression is reduced with isoflurane 
treatment (25 ± 8% intensity ratio over β-actin) compared 
to control (58 ± 21% intensity ratio over β-actin; P < 0.001) 

Fig. 4.  The effect of isoflurane (Iso) exposure and rapamycin treatment on the numbers of excitatory axon–oligodendrocyte progenitor 
cell (OPC) synapses in fimbria. The vesicular glutamate transporter 1–positive axon–oligodendrocyte progenitor cell synapses were identified 
with terminals apposing on neural/glial antigen 2–positive oligodendrocyte progenitor cells (arrows indicate these synapses). The number in 
isoflurane exposure mice was lower than control and rapamycin treatment rescued these axon–oligodendrocyte progenitor cell synapses. 
Scale bar = 5 μm. (A) Control. (B) Isoflurane exposure plus vehicle group. (C) Isoflurane exposure with rapamycin treatment. (D) Graph show-
ing quantitative data. n = 8 for each group; one-way ANOVA; **P < 0.01. Error bars: SD.

Copyright © 2019, the American Society of Anesthesiologists, Inc. Unauthorized reproduction of this article is prohibited.

D
ow

nloaded from
 http://asa2.silverchair.com

/anesthesiology/article-pdf/131/5/1077/461031/20191100_0-00024.pdf by guest on 10 April 2024



1086	 Anesthesiology 2019; 131:1077–91	

Perioperative Medicine

Li et al.

and a partial recovery results from rapamycin treatment (49 ± 
9% ratio; P = 0.006; fig. 6B). In order to determine whether 
changes in DNA methyltransferase 1 levels have functional 
significance, we assayed levels of 5-methylcytosine, which is a 
product of DNA methyltransferase 1–mediated DNA meth-
ylation, in oligodendrocytes. Isoflurane exposure decreased 
the ratio of 5-methylcytosine–positive nuclei over adeno-
matous polyposis coli–labeled oligodendrocytes (33 ± 13% 
ratio) relative to control (52 ± 13% ratio; P = 0.006), and 
rapamycin treatment reversed this decrease (48 ± 7% ratio; 
P = 0.031; fig. 6C).

Discussion
In this study, we report that early postnatal exposure 
to isoflurane in mice causes a substantial disruption of 

oligodendrocyte development and myelination in fimbria 
of the hippocampus, which is the predominant bundle of 
efferent axonal fibers from the hippocampus. Proliferation 
and differentiation of oligodendrocyte progenitor cells are 
chronically impaired by early isoflurane exposure, as is the 
formation of synaptic connections between oligodendro-
cyte progenitor cells and axons. This results in a measur-
able loss of myelin in the fimbria. Proper connections and 
communications between hippocampus and the neocortex 
are critical for performing the cognitive and psychologic 
functions.14,31,32 Myelination is essential in establishing con-
nectivity in the growing brain by facilitating rapid and syn-
chronized information transfer across the nervous system. 
Once thought of as solely a passive insulator, myelin is now 
understood to be actively involved in the function and 

Fig. 5.  The effect of isoflurane (Iso) exposure and rapamycin treatment on myelination in fimbria. (A) Myelination was quantitatively analyzed 
with myelin basic protein immunostaining. The myelin basic protein (MBP) intensity in isoflurane-exposed mice was reduced compared to con-
trol conditions and is increased with rapamycin treatment. For this analysis, the same exact photo setting was performed for all groups. Asterisk 
in photos: CA3 of hippocampus; fi: fimbria of hippocampus; LV: lateral ventricle. Scale bar = 200 μm. (B) Western blot data indicated expression 
of myelin basic protein was decreased by isoflurane exposure and then elevated by rapamycin treatment. (C) Electron microscopy analysis 
was performed in fimbria parasagittal ultrathin sections. The ratio of axonal caliber over diameter of myelinated fiber (g-ratio) was increased 
in isoflurane-exposed animals (it means decreased myelin thickness) compared to control, and rapamycin treatment reversed this change. 
Scale bar = 0.5 μm. n = 8 for each group in A and B, and n=100 for each group in C. One-way ANOVA; *P < 0.05; **P < 0.01. Error bars: SD.
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development of the CNS.33 Abnormal myelination of axons 
disrupts the communications between brain regions, and 
it has been reported that myelin deficits in the hippocam-
pus cause cognitive and psychologic disorders.34–36 Previous 
studies have shown an acute increase in apoptosis of oli-
godendrocytes, the myelin-forming glial cells, with early 
exposure to isoflurane,37,38 but our findings demonstrate a 
lasting effect of anesthesia on oligodendrocyte proliferation 
and differentiation that results in a decrease in myelination 
in the hippocampal fimbria.

The process of oligodendrocyte development occurs 
based on an intrinsic program that is modulated by neu-
rotransmitters and electrical activity in the CNS.39–41 Axonal 
terminals release glutamate as a transmitter not only at axo-
nal terminals but also at discrete sites along axons in white 

matter.42 By acting on α-amino-3-hydroxy-5-methyl- 
4-isoxazolepropionic acid (AMPA) or N-methyl-d-aspartate 
(NMDA) receptors expressed on oligodendrocyte progen-
itor cells, glutamate increases the downstream phosphor-
ylation of the cyclic adenosine monophosphate response 
element–binding protein and release of calcium from intra-
cellular stores,43 thereby promoting oligodendrocyte pro-
genitor cell proliferation and differentiation. As an agonist 
of γ-aminobutyric acid type A and glycine receptors,44 as 
well as a potential NMDA inhibitor,45 isoflurane suppresses 
excitatory neurotransmission.46 It raises the possibility that 
a profound direct action on oligodendrocyte progenitor 
cells, which express both γ-aminobutyric acid and NMDA 
receptors, is caused by isoflurane during a critical period 
in development and that this may alter the developmental 

Fig. 6.  The effect of isoflurane (Iso) exposure and rapamycin treatment on DNA methylation level in oligodendrocytes. (A) DNA methylation 
level examined with DNA methyltransferase 1 and Olig2 double immunolabeling. The percentage of DNA methyltransferase 1+/Olig2+ over 
Olig2+ nuclei in isoflurane-exposed mice was lower than control, and rapamycin increased this ratio. Scale bar = 25 μm. (B) Western blot 
data revealed isoflurane dramatically decreased the DNA methyltransferase 1 level, and rapamycin increased DNA methyltransferase 1. (C) 
5-Methylcytosine (5-mC), the product of DNA methylation catalyzed by DNA methyltransferase 1, was detected in nuclei of adenomatous 
polyposis coli  (APC)–positive oligodendrocytes. The ratio of 5-methylcytosine–positive/adenomatous polyposis coli–positive over adeno-
matous polyposis coli–positive cells showed a statistically significant decrease with isoflurane exposure and rapamycin injection reversed 
this decrease. Scale bar = 25 μm. n = 8 for each group; one-way ANOVA; *P < 0.05; **P < 0.01; ***P < 0.001. Error bars: SD.
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program, thus resulting in deficits in myelination. An alter-
native or complementary explanation may be an indirect 
effect mediated by the electrochemical synapses that occur 
between axonal terminals and oligodendrocyte progeni-
tor cells (axon–oligodendrocyte progenitor cell synapses). 
Formation of glutamatergic axon–oligodendrocyte pro-
genitor cell synapses plays an important role in promot-
ing activity-dependent oligodendrocyte development and 
maintenance.21–23 The chronic, lasting effects of isoflurane 
on neuronal synapses that we have previously shown may 
translate into reduced activity at axon–oligodendrocyte pro-
genitor cell synapses, thus leading to suppression of oligo-
dendrocyte progenitor cell development. A previous study 
showed that plasticity of axon–oligodendrocyte progenitor 
cell synapses is highly dependent on electrical activity.21 The 
data in this study further confirm that exposure of isoflu-
rane reduces the number of excitatory (vesicular glutamate 
transporter 1–positive) axon–oligodendrocyte progenitor 
cell synapses in hippocampus, which is likely a key mecha-
nism of general anesthetic–induced hypomyelination.

Our previous work has indicated that exposure to iso-
flurane disrupts the development of hippocampal neurons 
generated in the early postnatal period by inappropriately 
increasing activity in the mTOR pathway, and we found 
that both behavioral and histological changes could be 
reversed by pharmacologic mTOR inhibition.7 In the pres-
ent study, as in neurons, we observe a lasting alteration in 
the tone of mTOR signaling in oligodendrocytes in the 
hippocampal fimbria for a protracted period after isoflu-
rane exposure, which appears to be integral to the develop-
mental disruption. We found a substantial improvement in 
phenotype with rapamycin treatment in this study as well. 
The mTOR pathway is an intracellular signaling pathway 
that regulates cellular activities including proliferation, dif-
ferentiation, apoptosis, metabolism, transmitter release, and 
other biologic processes.18 In the past decade, many studies 
have implicated mTOR signaling in CNS developmental 
and neuropsychiatric disorders.19 Two structurally and func-
tionally distinct mTOR-containing complexes have been 
identified in oligodendrocytes. The first, mTOR complex 
1 mTOR, contains the adaptor protein Raptor, which 
influences myelin basic protein expression via an alternative 
mechanism and is sensitive to the drug rapamycin. The sec-
ond complex, mTOR complex 2, contains Ritor, and it is 
thought to control myelin gene expression at the mRNA 
level and is relatively rapamycin-insensitive.47

The mTOR pathway itself plays a complex role in 
myelination; mTOR activity can either enhance or suppress 
oligodendrocyte development depending on the context. 
A study using a mouse line with oligodendrocyte-specific 
knockdown of mTOR in CNS has provided evidence that 
mTOR is essential for oligodendrocyte development and 
myelination.48 Inhibition of mTOR via rapamycin in cul-
tured adult oligodendrocyte progenitor cells or in a mouse 
model starting at 6 weeks of age results in oligodendrocyte 

differentiation deficits along with reduced expression of 
major myelin proteins and mRNAs.49–51 In contrast, acti-
vation of mTOR induced by tuberous sclerosis complex–1 
or –2 gene mutations in early oligodendrocyte progenitor 
cells caused white matter abnormalities, including myelin 
deficits in CNS.52–54 A bidirectional action of the phos-
phoinositide 3-kinase-protein kinase B-mTOR (PI3K-
Akt-mTOR) axis in myelination has also been reported in 
studies of the peripheral nervous system. If tuberous sclerosis 
complex–1 deletion occurs in early developmental stages in 
Schwann cells, mTOR hyperactivity arrests the process by 
which Schwann cells ensheathe axons. If mTOR activity is 
increased in Schwann cells after they have begun wrapping 
around axons, there is actually an increase in myelination.55 
Thus, oligodendrocyte development and myelination may 
be dependent on precise balance and timing in mTOR 
signaling. Either increasing or decreasing levels of mTOR 
complex 1 activity interferes with oligodendrocyte differ-
entiation and causes potentially causes hypomyelination.56

While we do not yet have a clear picture of how changes 
in mTOR activity act on oligodendrocytes, our data indi-
cate changes in DNA methylation as a promising direction. 
Recent work shows developmental anesthetic toxicity may 
involve epigenetic modulation57 and that DNA methyla-
tion plays an important role in regulating oligodendro-
cyte progenitor cell proliferation and differentiation.26–28 
Intriguingly, mTOR signaling has been shown to negatively 
regulate DNA methylation via an action on DNA methyl-
transferase 1,24,25 suggesting a possible connection between 
mTOR signaling and oligodendrocyte development. This 
finding is consistent with our data showing that isoflurane 
exposure and concomitant increases in mTOR signaling 
lead to a decrease in DNA methyltransferase 1 expression 
and DNA methylation in developing oligodendrocytes, and 
that both of these changes are reversible with rapamycin 
treatment.

We propose that oligodendrocytes should be further 
studied both as a potential target in anesthetic neurotoxic-
ity and as a model system in which to further explore the 
interplay of anesthetics,  mTOR signaling, and DNA meth-
ylation. Our work is limited by the rodent model, which has 
well-known confounds related to anesthetic administration 
in very young, small mice in which physiologic monitor-
ing and control of respiratory function are challenging. In 
particular, we have chosen to use 100% oxygen as a carrier 
for isoflurane, which has the beneficial effect of preventing 
hypoxia in our model system, but which raises the possibil-
ity of a combined effect of isoflurane and hyperoxia dam-
age that cannot be fully controlled for in our experimental 
model. While it is indeed the case that supplemental oxygen 
is frequently used in pediatric anesthesia practice, it would 
be ideal to avoid confounds presented by hyperoxia and 
other physiologic issues via studies in large animal models 
and in cell culture models, and we hope further work in this 
area will be undertaken in these systems.
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